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Questo manuale operativo fornisce le istruzioni per eseguire il controllo qualità e il trattamento 
preliminare dei dati da sub bottom profiler acquisiti con sistema Topas PS18. 
Lo scopo è quello di fornire un dataset in formato SEGY leggibile dai più comuni software di 
interpretazione.

Il manuale è organizzato in slide raggruppate per argomento; tutte le istruzioni sono fornite con l’ausilio 
di snapshot di elaborazioni eseguite su dataset reali. 
Per l’esecuzione delle operazioni descritte non sono necessarie particolari competenze geofisiche; è però 
indispensabile dotarsi dei software Topas Replay e Vista.

Assieme al manuale sono distribuiti:
1. Dataset di esempio
2. Cinque flow di Vista che sono:

«01-IRIDYA-CORRECTION FOR DELAY.flw», descritto nella slide 2.9;
«02-IRIDYA-NEG STAT SHIFT.flw», descritto nella slide 2.10;
«03-IRIDYA-ENVELOPE.flw», descritto nella slide 2.11;
«04-IRIDYA-SEGYOUT.flw», descritto nella slide 2.12;
«05-IRIDYA-NAV EXPORT.flw», descritto nella slide 2.13.
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Software TOPAS 3.2.  REPLAY

Obiettivi 1. Verifica ed esportazione dei 
file di navigazione

2. Conversione dal formato 
.raw al formato .sgy (o .segy) 
dei file acquisiti

1 LAVORARE CON IL SOFTWARE TOPAS REPLAY 



Organizzare le cartelle di lavoro1.1

AZIONI

1. Creare le seguenti cartelle:

a) DATI RAW (dove andranno collocati i  file acquisiti);

b) DATI SEGY, a sua volta suddivisa in:

c) NAVIGAZIONE, a sua volta suddivisa in:

d) ELABORAZIONE, che ospiterà il progetto VISTA

L’organizzazione qui proposta è solamente indicativa; non esistono vincoli né limitazioni in tal senso. 
E’ comunque caldamente consigliata per mantenere l’ordine nelle proprie cartelle di lavoro.

• INPUT FROM TOPAS, che ospiterà i   file  SEGY 
generati da Topas Replay e che costituiranno 
l’input di Vista;

• OUTPUT from VISTA, dove andranno collocati i file 
SEGY esportati da Vista e da consegnare.

• FROM VISTA, dove saranno collocati i file di 
navigazione in formato ASCII generati da Vista;

• KML, dove andranno collocati i file .kml generati 
da TOPAS REPLAY

• GMP, se si intende generare mappe con Global 
Mappe



Verificare la navigazione ed estrarre il file .kml1.2

AZIONI 1. Menu File > selezionare File(s) to KML
2. a. Se nella cartella DATI RAW è presente/sono presenti SOLO il/i file da cui estrarre la navigazione, 

selezionare «Directory for Topas[*.raw] files». (SCELTA RACCOMANDATA).                                                         
b. Se nella cartella DATI RAW sono presenti tutti i file registrati, selezionare «File Saved in Topas
[*.raw] format». In questo caso sarà però possibile lavorare su un solo file per volta.

3. Selezionare la cartella NAVIGAZIONE, e indicare il nome del file .kml da salvare. Al termine comparirà 
un messaggio di completamento dell’operazione nella finestra «System messages», dove saranno 
elencati i files processati  e il messaggio «End of input data» in coda. 
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Convertire i file .raw in formato .sgy ed esportarli 1/31.3

AZIONI 1. Cliccare sul pulsante contraddistinto dal pallino verde. Si aprirà la finestra di dialogo Windows
2. Indicare il nome del file SEGY da salvare. Notare sulla parte inferiore della finestra la barra rossa con 

scritto «Not Logging Pro».

1
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Convertire i file .raw in formato .sgy ed esportarli 2/31.3

AZIONI

3

3. Cliccare sul tasto «PLAY». Si aprirà la finestra di dialogo Windows
4. Indicare la cartella RAW, dove sono presenti i file da elaborare

4



Convertire i file .raw in formato .sgy ed esportarli  3/31.3

5. Cominceranno a scorrere i dati così come sono stati acquisiti. La barra in basso a sinistra diventerà verde (a 
indicare che il dato viene elaborato); contestualmente si aprirà una finestra di messaggio che si popolerà 
con la sequenza dei file processati. Alla fine comparirà il messaggio «End of Input data».  Fare clic su OK. 

AZIONI

5



Nota sul processing1.4

Durante l’acquisizione con sistema Topas il dato in formato .raw, cioè non 
processato, viene salvato di default; non così il dato in formato SEGY, il cui 
salvataggio deve essere esplicitato dall’utente. La differenza tra i due, però, 
non è solo di formato (.raw proprietario, .segy standard di interscambio). 
Al dato salvato durante l’acquisizione in formato SEGY vengono infatti 
applicati tutti i processi di elaborazione elencati nella scheda «Processing»
(e attivi in quel momento). 
Di solito è preferibile applicare questi processi solamente per fini cosmetici 
e di visualizzazione durante l’acquisizione, salvare SOLAMENTE la versione 
.raw e rimandare il processing a una fase successiva, comunque offline.
Esattamente come la versione di acquisizione Topas PS18, anche la 
versione Replay mette a disposizione una serie di processi che si possono 
applicare al dato prima di salvarlo in formato SEGY. E’ bene non abusare di 
questi processi perché una volta salvati i dati, i processi applicati non sono 
reversibili.

I processi applicabili sono elencati anche in questo caso nella scheda 
«Processing»: quelli non attivi appaiono in carattere grigio, quelli attivi in 
carattere nero e sono preceduti da una freccia nera. Per attivare un 
processo, bisogna cliccarci sopra e apporre un segno di spunta sulla casella 
«Enabled» (nella finestra di dialogo relativa a quel processo, che compare 
nella parte inferiore). Impostati i parametri, fare click sul pulsante «Apply». 
Nel caso illustrato, è stata evidenziata la finestra di dialogo del processo 
«Gain».



Software VISTA SCHLUMBERGER
(versione 2018 e precedenti)

Obiettivi 1. Compensazione dei delay 
time

2. Processing dei dati (se 
necessario)

3. Esportazione dei dati in 
formato wiggle e/o envelope
(se necessario) in formato 
SEGY

4. Esportazione della 
navigazione su un file di 
testo

2 LAVORARE CON IL SOFTWARE VISTA



Avviare Vista (con licenza dongle)2.1

AZIONI

1. Menu principale > License > 
Run Schlumberger Licensing
Tool – configure Local Licence
Server (Elevated)

2. Si aprirà la finestra 
«Schlumberger Licensing». 
Cliccare Start. Verificare sulla 
maschera «Message Log» (in 
basso a sinistra) che il 
processo sia partito.

3. Cliccare OK.
4. Uscire da Vista e riavviarlo.

Nel caso in cui il processo non 
parta, provare a disconnettersi 
dalla rete e ripetere l’operazione. 
Una volta partito il processo e 
riavviato Vista, ci si potrà 
riconnettere alla rete senza alcun 
problema.
Verificare eventualmente i 
permessi del firewall.
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Vista si avvia sempre in modalità DEMO. E’ necessario perciò abilitare la licenza ogni volta e riavviare.



Creare un nuovo progetto 1/22.2

2

3

4

1

AZIONI

1. Verificare che Vista si sia avviato in modalità FULL OPERATIONAL (barra del titolo in alto a sinistra)
2. Menu principale > File > New Project
3. Si aprirà la finestra «New Vista Windows Project File». Assegnare il nome del file di progetto (estensione .vwn) 

ubicandolo nella cartella ELABORAZIONE (vedi slide 1.1). Tutti i file di input ouput, i flows, ecc. rimarranno all’interno 
delle sottocartelle di ELABORAZIONE. Click sul pulsante Salva

4. Selezionare «2-D Survey» nella scheda cliccare OK.

Alla prima sessione di Vista è necessario creare un progetto, che diventerà il «contenitore» del nuovo dataset e di tutti i 
file ad esso collegati.



Creare un nuovo progetto2.2

Quando si crea un nuovo progetto, Vista genera una 
cartella NomeProgetto-files (1) e un file 
NomeProgetto.vwn (2), che è quello al quale si 
punterà per ogni accesso successivo al primo.

La cartella NomeProgetto.vwn è a sua volta suddivisa 
in cinque sub-cartelle (3) che sono:
- Flows, dove saranno inseriti di default i flows da 

applicare ai dati;
- MiscFiles, dove l’utente potrà salvare file di testo, 

files di parametri, ecc.
- Output, dove Vista colloca di default i files generati 

dai flows in formato proprietario;
- Temp, dove risiedono files temporanei di sistema;
- Vistalogs, che contiene i log generati 

automaticamente dal sistema.

Creare un nuovo progetto 2/2
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AZIONI

Trasferire i cinque file .flw consegnati con questo 
manuale nella cartella «Flows» (4)

4



Aprire un progetto esistente2.3

AZIONI

1. Menu principale > File > New Project. Si aprirà la finestra 
«Vista Project File Open». Selezionare il file .vwn e cliccare 
Apri.

2. Menu principale > File > Recent Project per accedere alla 
cronologia dei progetti sui quali si è lavorato recentemente
e scegliere quello che si vuole aprire.

Dalla seconda sessione di Vista in poi, l’accesso al progetto è quello classico di tutti gli applicativi Windows

1
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La Project Data List2.4

E’ la finestra principale di Vista, che compare quando si accede a un progetto. E’ suddivisa in tre aree: 
1. Diagramma ad albero, dove è indicata la lista dei Data Group (uno per linea) che compongono il dataset.
2. Area che contiene i file di ciascun Data Group, che si popolerà dei file originali e di quelli elaborati
3. Elenco dei sort disponibili, che definisce le varie chiavi di accesso ai dati (questo argomento non sarà qui trattato)

1
2
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Creare un Data Group2.5

AZIONI 1. Click destro sulla voce DATA del diagramma ad albero. Selezionare «Add New Data Group» e assegnare un 
nome al nuovo gruppo nella maschera «Add New Seismic Data Group» che sarà comparsa nel frattempo. Il 
gruppo appena creato comparirà come sottogruppo DATA. 

Per mantenere l’ordine all’interno del dataset, è conveniente creare un nuovo Data Group per ciascun profilo da processare

1



Importare un file SEGY nel Data Group2.6

AZIONI 1. Avendo verificato di trovarsi all’interno del Data Group corrente, premere il pulsante 2D, e automaticamente 
comparirà la riga 1, denominata [1]: NEW 2-D DATA. Il software ha allocato lo spazio per un nuovo set di 
dati, che andremo a importare.

2. Premere il pulsante contraddistinto da una pagina con delle righe di testo e un + verde per importare il/i file 
da elaborare.

L’obiettivo è quello di popolare il Data Group con i file SEGY generati da Topas Replay

1/4

1

La nuova riga compare dopo aver premuto il pulsante 2D

2



Importare un file SEGY nel Data Group

AZIONI

2/4

3. Selezionare il radio button «Create New Seismic Data Set for Files»
4. Cliccare sul pulsante «Add File(s)». (si possono selezionare anche più files, che saranno tutti assegnati al 

nuovo dataset ad un singolo file. Se questo è il caso, verificare visivamente la continuità del fondale tra due 
file contigui). E’ consigliabile apportare un segno di spunta a «Create New Seismic Data(...)». Con questa 
operazoione il sistema creerà una copia fisica del file originale e la convertirà in formato proprietario. 
Questo aumenta lo spazio occupato ma il file originario non verrà più interessato dai processi di Vista. Al 
termine, Si aprirà la classica finestra di input di Windows, in cui si selezionerà il/i file da importare

3
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Importare un file SEGY nel Data Group

AZIONI

3/4

5. Verificare che le informazioni riportate nella scheda «Input SEG-Y Seismic Data File(s) – Nomefile» abbiano 
un senso (Start Time, Sample Rate, ecc.) ed, eventualmente, aprire tutti i tab presenti (ad esempio view
seismic). Se soddisfatti, premere OK.

6. La scheda «Input Multiple SEG-Y Disk File(s)» si aggiornerà con il/i file selezionati. Premere il pulsante OK 
per iniziare l’importazione

5
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2.6



Importare un file SEGY nel Data Group

AZIONI

4/4

7. Completata l’operazione, il sistema visualizzerà la tabella 
«Transfer Header Info Seismic – Nomefile» che riporta l’elenco 
delle header contenute nel file importato. Verificare la 
congruenza delle informazioni contenute. In particolare 
controllare che siano presenti le coordinate del dato.

8. A questo punto anche la «Project Data List» risulterà 
aggiornata con l’aggiunta al Data Group del nuovo file, il cui 
nome comparirà sia nel diagramma ad albero che nell’elenco 
dei file contenuti nel gruppo

7

8

Il nuovo file è una copia in formato proprietario del 
file originale

NOTA

2.6



Visualizzare il file importato  1/32.7

AZIONI

1

1. Fare click sull’icona «traccia 
sismica» e si aprirà la 
finestra di visualizzazione

1



Visualizzare il file importato                                             2/3

AZIONI 2. Poiché la visualizzazione di default non si adatta bene a questo tipo di file, è necessario impostare nuovi 
parametri. Fare click sulla prima icona in alto a sinistra. Comparirà la finestra «Seismic Plot Parameters»

2

3. Dal menu a tendina «Display Type» 
selezionare «Variable Density». (il 
default è «Wiggle/Variable Area»)

4. Selezionare una «Color Bar 
appropriata» dal relativo menu a 
tendina (ad esempio red-blue) 3

4

5. Definire una finestra di visualizzazione 
in tempi (se necessario)

6. Cambiare il numero «Max Trcs/Panel» 
(default 240). Per dati SBP, un numero 
compreso tra 5000 e 10000 Trcs/Panel 
dovrebbe andar bene.

6

5

2.7



Visualizzare il file importato                                             3/3

Al termine il dato si dovrebbe presentare come illustrato nella figura sottostante, ottenuta reimpostando i 
parametri: Display Type > Variable density; Color Bar > Red-Blue; Max Time > 200; Max Trcs/panel > 6500
Il tempo 0 (T0) di ciascun segmento di linea corrisponde al Delay Time applicato (e registrato nelle header)

2.7



Visualizzare e ispezionare la header «Delay Time»     2.8

AZIONI 1. Per visualizzare il contenuto delle header fare click sul pulsante «H»

1

2
3

4

5

Salto del 
fondale

2. Click sul pulsante «Shot» (comparirà la colonna «SHOT_POINT_NO»)
3. Click sul pulsante «Attr»; tenendo premuto il tasto del mouse,  

selezionare «Time» nella sottostante barra di icone.
4. Dal menu a tendina selezionare la header «Delay Time»
5. Click pulsante «+» verde. Comparirà la colonna «DELAY-TIME»
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Per compensare l’applicazione del «Delay Time» in fase di acquisizione, e ottenere così un dato in cui il fondo mare risulti 
continuo e senza «salti» tra i vari segmenti (indicati in figura dalla sigla sn), sarà necessario applicare una correzione statica 
pari al «Delay Time» stesso. Al termine del processo la nuova Lunghezza di Registrazione (LR) sarà data dalla 2. 
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1. LR iniziale = End - Start
2. LR finale =   End - Start + Delay Time Max
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Applicare i «Delay Time»                                                1/112.9



Applicare i «Delay Time»                                                2/112.9

AZIONI

Il «Delay Time» viene registrato nella corrispondente voce di header (vedi sotto).
Prima di applicare la correzione, è indispensabile definire quale sarà la massima durata temporale del dato al termine 
dell’operazione. Tale valore è il risultato dalla somma tra la lunghezza della registrazione e il Delay Time massimo. 

1. La lunghezza della registrazione si legge sulla riga che riporta gli estremi del profilo alla voce «END»

1

2. Al valore di Delay Time massimo si accede cliccando 
sul pulsante «Hf», che apre la finestra «Vista-Header
Min/Max» in cui vengono riportati i valori minimo e 
massimo di tutte le header dei dati.

3. Fare click sul pulsante «Time» per accedere al 
gruppo di header legate al tempo. Verificare i valori 
minimo e massimo della voce «DELAY-TIME». Il 
valore massimo di Delay è di 2700 ms.

2

Per l’esempio riportato, la nuova lunghezza del 
dato idonea a contenere tutti gli eventi riflessi 
sarà perciò di 300 ms + 2700 ms = 3000 ms



Applicare i «Delay Time»                                                3/11

AZIONI 4. Menu principale > Job Flow > Open Flow File.
5. Selezionare il flow «01-IRIDYA-CORRECTION FOR DELAY.flw» nella cartella Flows puntata di default dal 

software e click su «Apri»

Per aprire il flow «01-IRIDYA-CORRECTION FOR DELAY.flw» distribuito assieme a questo manuale:

4 5

Si aprirà la finestra qui a fianco, che contiene tre 
moduli: il primo è il modulo di input, in cui si seleziona il 
file da elaborare, il secondo è il processo vero e proprio 
(«Static Shift») che applica la correzione, il terzo è il 
modulo di output in cui si dà un nome al file processato 
e se ne indica l’ubicazione 

input outputprocesso

2.9



Applicare i «Delay Time»                                                4/11

AZIONI 1. Fare doppio click sul modulo «Input», si aprirà la finestra «Flow Input Command»
2. Nella scheda «Input» selezionare il file da processare (nell’esempio, IRIDYA-01-TMP), cliccando sul nome
3. Nella scheda «Window» impostare l’End Window a 3000 ms (Max Delay + Lunghezza Record)

Impostare i parametri del modulo «Input»

1. Doppio click

2

3

2.9



Applicare i «Delay Time»                                                5/11

AZIONI 4. Fare doppio click sul modulo «Static Shift», si aprirà la finestra «Apply Static Shift»
5. Selezionare il radio button Header Static. Selezionare la voce «Delay Time» dal menu a tendina.
6. Confermare con OK

Impostare i parametri del modulo «Static Shift»

4. Doppio click

5
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2.9



Applicare i «Delay Time»                                                6/11

AZIONI 7. Fare doppio click sul modulo «Output», si aprirà la finestra «Flow Output Command»
8. Nella scheda «Display», scrivere il nome del file da salvare
9. Nella scheda «Output», indicare l’ubicazione del file da salvare apponendo segno di spunta a «Specify

Group» e selezionando il gruppo dal menu a tendina alla voce «Output Group»

Impostare i parametri del modulo «Output»

7. Doppio click

8
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2.9



Applicare i «Delay Time»                                                7/11

AZIONI 10.Click sul rettangolo verde nel menu verticale laterale
11.Tenendo premuto il tasto sx del mouse, selezionare un’area rettangolare che comprenda tutti i moduli, 

rilasciare il tasto alla fine. La barra verticale gialla (indicata in figura dalla freccia rossa) del modulo input 
dovrebbe diventare verde. A questo punto tutti i moduli sono pronti.

12.Click sul pulsante «GO» del menu principale. Se il processo è regolare, si aprirà la finestra «Execute Flow» 
dove è riportata la barra di avanzamento del processo e un log di testo delle operazioni applicate.

Far girare il flow

10
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12

2.9

Semaforo verde



AZIONI 1. Zoom interattivo. Tenendo premuto il tasto sx del mouse a sinistra dell’asse dei tempi, selezionare un’area 
rettangolare (rappresentata da una banda gialla la cui estensione verticale rappresenta lo zoom lungo l’asse 
dei tempi) fino al livello di zoom desiderato. Rilasciare il tasto alla fine.

2. Impostando il tempo massimo e minimo di visualizzazione. Fare click sul pulsante «Plot» per accedere alla 
finestra «Seismic Plot Parameters».

3. Nella scheda «Display»,  apporre un segno di spunta a «Force Time Window» e indicare i valori minimo («Min. 
Time») e massimo («Max time») della finestra da visualizzare.

Nella figura sottostante si riporta il risultato finale (si rimanda alla scheda 2.6-2/3 per l’impostazione dei parametri correttidi
visualizzazione). Naturalmente, rispetto alla versione iniziale, il dato risulta molto appiattito per l’aggiunta dei Delay Time.
Per una visualizzazione ottimale e confinata entro la finestra in cui è presente il dato, si può agire in due modi:

Applicare i «Delay Time»                                                8/11
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Al termine, il risultato dovrebbe apparire come illustrato in figura. A questo punto il dato è pronto per l’elaborazione finale.
Prima di esportare il file in formato SEGY, potrebbe valere la pena applicare ancora un o due processi (facoltativi) che 
saranno spiegati nelle prossime slide e dei quali è consigliabile consultarsi con il responsabile scientifico.

Applicare i «Delay Time»                                                9/11

Cambio di Delay Time

2.9



Solitamente Vista visualizza di default il file appena creato. Uscendo dalla finestra di visualizzazione e tornando alla «Project 
Data List», si potrà osservare che il nuovo file è stato correttamente posizionato all’interno del gruppo voluto; infatti 
compare al secondo posto nella lista dei file presenti al suo interno. Da notare inoltre che i valori applicati sono stati 
registrati automaticamente nella voce di header «STATIC_APPLIED_TOTAL».

Applicare i «Delay Time»                                              10/112.9

Nuovo file

1. Fare click su «Hf» per visualizzare i valori minimi e 
massimi di ciascuna header

2. Fare click sul tasto «Time». Apparirà una lista di 
tutte le header legate al tempo.

AZIONI

1

2
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Come già illustrato in 2.9 / 1.10, la Lunghezza di Registrazione (LR) finale è stata aumentata di una finestra pari al Delay Time 
Max (infatti la nuova LR è di 3000 ms). A questo punto si pone il problema di decidere se valga la pena esportare il file nella 
sua interezza (aumentando a dismisura le dimensioni del file SEGY) o piuttosto ridurne la lunghezza. E’ un’opzione da 
sottoporre a chi dovrà gestire i dati. Nelle prossime slide si illustrerà questa operazione (opzionale).
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1. LR iniziale = End - Start
2. LR finale =   End - Start + Delay Time Max
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Se è stato deciso di risparmiare spazio di memoria, allora si rende necessario ridurre le dimensioni dei file da esportare, 
intervenendo nuovamente sulla lunghezza del dato. Per fare ciò, è necessario applicare una ulteriore correzione statica 
negativa (cioè verso l’alto), come illustrato nella figura sottostante. L’ammontare minimo della correzione  da apportare sarà 
pari al Delay Time minimo. Potrà essere ovviamente anche maggiore; basterà avere l’accortezza di evitare che il fondo mare 
risulti tagliato sul dato corretto (è sufficiente un controllo visivo dei dati per non sbagliare).
Il flow che svolge questa operazione si chiama «02-IRIDYA-NEG STAT SHIFT.flw»

Applicare una statica negativa (opzionale)              1/122.10
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AZIONI 1. Menu principale > Job Flow > Open Flow File.
2. Selezionare il flow «02-IRIDYA-NEG STAT SHIFT.flw» nella cartella Flows puntata di default dal software e 

click su «Apri»

Per aprire il flow «02-IRIDYA-NEG STAT SHIFT.flw» distribuito assieme a questo manuale:

1
2

Si aprirà la finestra qui a fianco, che contiene 
cinque moduli: il primo è il modulo di input, 
in cui si seleziona il file da elaborare, il 
secondo, terzo e quattro applicano i processi 
veri e propri, il quinto è il modulo di output 
in cui si dà un nome al file processato e se ne 
indica l’ubicazione 

input outputprocessi
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AZIONI 3. Fare doppio click sul modulo «Input», si aprirà la finestra «Flow Input Command»
4. Nella scheda «Input» selezionare il file da processare (nell’esempio, IRIDYA-01-TMP.DELAY TIME 

CORRECTED), cliccando sul nome.

Impostare i parametri del modulo «Input»

3. Doppio click

4
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AZIONI 5. Fare doppio click sul modulo «Bulk Shift», si aprirà la finestra «Apply Bulk Static»
6. Nella casella di testo «Time Static» scrivere il valore del «Delay Time minimo» (2300 in questo caso)

Impostare i parametri del modulo «Bulk Shift», che applica una correzione statica verso l’alto

5. Doppio click

Valori negativi per 
shift verso l’alto!

6
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AZIONI 7. Fare doppio click sul modulo «Edit Header», si aprirà la finestra una finestra di dialogo in cui si possono 
specificare le voci di heade sulle quali compiere varie operazioni.

8. Con le stesse modalità illustrate in precedenza (slide 2.8, punto 3), selezionare la voce «Delay Time»
9. Fare click sul «+» verde. La voce di header DELAY_TIME sarà stata aggiunta alla lista su cui operare.

Impostare i parametri del modulo «Editheader», per salvare nelle header il valore di statica applicato

7. Doppio click

8

9
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AZIONI

Impostare i parametri del modulo «Editheader», per salvare nelle header il valore di statica applicato

10

11

12

10. Fare click sul quadratino a fianco del nome della header. Si aprirà la finestra «Dictionary Item: 
DELAY_TIME»

11. Fare click sul pulsante «CONSTANT» per assegnare alla header selezionata un valore costante
12. Fare click sul radio button «Assign Constant» e scrivere nella casella di testo il valore applicato. 

Confermare con OK e OK per chiudere tutto
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AZIONI

Impostare i parametri del modulo «Editheader», per salvare nelle header il valore di statica applicato

13

13. Fare click sul pulsante «-» per confermare l’operazione e chiudere la finestra di editing delle header: 
DELAY_TIME». Si aprirà il modulo «Flow Command: Edit/Dfine Header Mapping».

14. Fare click sul pulsante «SAVE»

14
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15. Doppio click

AZIONI 15. Fare doppio click sul modulo «Window» per indicare la nuova lunghezza del dato (LR). Si aprirà la finestra 
«Window Data».

16. Scrivere 0 nella casella di testo «Start Window» e la lunghezza desiderata nella casella «End Window»

Impostare i parametri del modulo «Window», per ridurre la lunghezza del dato

ATTENZIONE!
Il valore di End 
Window dipende 
dall’estensione 
della finestra 
temporale 
occupata dal dato.

End Window

Start Window

16

LR
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17. Doppio click

AZIONI

Impostare i parametri del modulo «Window», per ridurre la lunghezza del dato

17. Fare doppio click sul modulo «Output», si aprirà la finestra «Flow Output Command»
18. Nella scheda «Display», scrivere il nome del file da salvare
19. Nella scheda «Output», indicare l’ubicazione del file da salvare apponendo segno di spunta a «Specify

Group» e selezionando il gruppo dal menu a tendina alla voce «Output Group»

18

19



AZIONI 20. Click sul rettangolo verde nel menu verticale laterale
21. Tenendo premuto il tasto sx del mouse, selezionare un’area rettangolare che comprenda tutti i moduli, 

rilasciare il tasto alla fine. La barra verticale gialla (indicata in figura dalla freccia rossa) del modulo input 
dovrebbe diventare verde. A questo punto tutti i moduli sono pronti.

22. Click sul pulsante «GO» del menu principale. Se il processo è regolare, si aprirà la finestra «Execute Flow» 
dove è riportata la barra di avanzamento del processo e un log di testo delle operazioni applicate.

Far girare il flow
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20

21

22



Al termine, il risultato dovrebbe apparire come illustrato in figura. A questo punto il dato è pronto per essere esportato. A
prima vista l’immagine è identica a quella riportata nella slide 2.9 -9/10. Si noti però che in questo caso l’asse dei tempi 
parte da 0 ms (che in realtà corrispondono ai 2300 ms di statica applicati!)
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Come nel caso precedente, si osserverà che il nuovo file è stato aggiunto in coda alla lista del gruppo di appartenenza.

2.10

Nuovo file
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Noteremo inoltre che il nuovo file ha la lunghezza temporale 
di 700 ms (rispetto ai 3000 ms della versione precedente).
Inoltre ispezionando la liste delle «Time Header», vedremo 
che, come desiderato, la voce «DELAY_TIME» è stata 
aggiornata al valore richiesto di 2300 ms (costante su tutta 
la linea).
I valori originali di «DELAY_TIME», come osservato in 
precedenza, sono stati immagazzinati nella voce 
«STATIC_APPLIED_TOTAL», e sono quindi sempre 
recuperabili se necessario.
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Nel caso si rendesse necessario o fosse richiesto, anche solo per motivi estetici (ad esempio per dati molto disturbati) 
potrebbe essere utile ricorrere alla visualizzazione dell’inviluppo dei dati sub bottom; questa modalità di visualizzazione 
«classica» si ottiene con un processo che in pratica ribalta le ampiezze negative e calcola l’inviluppo del risultato. La perdita 
di polarità, che impedisce l’applicazione di alcuni algoritmi standard di elaborazione sismica, è compensata da un 
rafforzamento dei segnali più deboli. L’operazione si applica attraverso il flow «03-IRIDYA-ENVELOPE.flw».

AZIONI

1. Click sul rettangolo verde nel menu verticale laterale
2. Tenendo premuto il tasto sx del mouse, selezionare un’area 

rettangolare che comprenda tutti i moduli, rilasciare il tasto alla 
fine. La barra verticale gialla (indicata in figura dalla freccia rossa) 
del modulo input dovrebbe diventare verde. A questo punto tutti i 
moduli sono pronti.

Si assume a questo punto che le operazioni di apertura del flow e di 
impostazione dei parametri di input e output siano state assimilate. Il 
modulo «Envelope», inoltre, non necessita di ispezione in quanto non ci 
sono parametri da settare. 

3. Click sul pulsante «GO» del menu principale. 
Se il processo è regolare, si aprirà la finestra 
«Execute Flow» dove è riportata la barra di 
avanzamento del processo e un log di testo 
delle operazioni applicate.

1

2

3input output
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Al termine, il nuovo file sarà stato aggiunto alla lista del gruppo.

AZIONI

1. Con le solite procedure già viste nelle slide precedenti, visualizzare il dato 
premendo il pulsante traccia sismica

2. Premere il tasto plot nella finestra di visualizzazione. Nella finestra 
«Seismic Plot Parameters» selezionare i settaggi visualizzati.

1

2

3. Click destro sulla colorbar
«Amplitude».

4. Selezionare settings > 
Reverse Colors

3

4
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Al termine il dato dovrebbe comparire come in figura. Per zoomare ci sono tre possibilità. La prima è già stata descritta in 
2.9 – 8/10, e consente di zoomare solo lungo l’asse dei tempi. La seconda, non illustrata, segue la stessa procedura e 
consente di zoomare lungo l’asse delle distanze (basterà in questo caso posizionarsi all’interno della barra degli shot).
La terza permette lo zoom su una finestra. Fare click col tasto sx all’interno della finestra e trascinare tenendo il tasto del 
mouse premuto fino al livello di zoom desiderato. 

Click SX

Rilasciare

Trascinare
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L’ultimo passo è quello di esportare i dati generati da Vista in formato SEGY. Nell’esempio riportato si esporteranno sia i dati
wiggle che envelope.

AZIONI 1. Menu principale > Job Flow > Open Flow File.
2. Selezionare il flow «04-IRIDYA-SEGYOUT.flw» nella cartella Flows puntata di default dal software e click su 

«Apri»
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AZIONI 1. Fare click sul modulo «Input» e selezionare il file «IRIDYA-01-TMP.DELAY TIME CORRECTED-NEG SHIFT»
2. Fare click sul modulo «input» e selezionare il file «IRIDYA-01-TMP.ENVELOPE»

Aprendo il flow, si vedranno comparire due coppie di moduli identici, che possono essere fatti girare contemporaneamente. 
Quella superiore permette di esportare i dati wiggle, quella i dati envelope. 

1. Doppio click

2. Doppio click
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AZIONI

3. Fare click sul modulo «SEGYOut». Si 
aprirà La finestra «Output SEG-Y 
Seismic Data File. Non è necessario 
cambiare parametri.

4. Click sul pulsante File
5. Selezionare il percorso come in figura
6. Assegnare il nome al file da salvare
7. Click Salva 

3. Doppio click

4

5

6

7
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AZIONI

8. Fare click sul modulo «SEGYOut». Si 
aprirà La finestra «Output SEG-Y 
Seismic Data File. Non è necessario 
cambiare parametri.

9. Click sul pulsante File
10. Selezionare il percorso come in figura
11. Assegnare il nome al file da salvare
12. Click Salva 

9

10

11

12

8. Doppio click
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AZIONI

15

13

13. Selezionare i quattro moduli
14. Click sul pulsante GO
15. Al termine, verificare che i file siano 

stati salvati correttamente. Assieme al 
file SEGY viene salvata un file di testo 
SEGYLOG che riporta i termini 
dell’operazione

14
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Qualora lo si ritenesse necessario, è possibile esportare la navigazione di ciascun profilo su file di testo. Ricordiamo che la 
navigazione, intendendo con tale termine la coppia di coordinate geografiche Longitudine e Latitudine associata a ciascuno 
shot, è immagazzinata in secondi d’arco nelle header XSHOT e YSHOT rispettivamente. Per convertire questa unità in gradi, è 
necessario dividere il valore per 3600. Per visualizzare queste informazioni, seguire le seguenti istruzioni. 

AZIONI 1. Click sul pulsante «H» nella «Project Data List»
2. Click sul simbolo «Shot» per visualizzare la colonna «SHOT_POINT_NO» nella finestra «Seismic Header

View/Edit»
3. Click sull’icona «Attr»; tenendo premuto selezionare l’icona Geo, che dà l’accesso a tutte le voci di header

relative a coordinate e distanze

1

2

3
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AZIONI 4. Selezionare dal menu a tendina la voce XSHOT 
5. Cliccare sul pulsante «+» verde. Verrà aggiunta la colonna XSHOT. Ripetere l’operazione per la voce YSHOT.

4

5
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AZIONI

Per esportare in un file di testo le informazioni contenute nelle header «XSHOT» e «YSHOT», seguire la seguente procedura

1. Menu principale > Job Flow > Open Flow File.
2. Selezionare il flow «05-IRIDYA-NAV EXPORT.flw» nella cartella Flows puntata di default dal software e click su 

«Apri»

1

2
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AZIONI 3. Doppio click sul modulo «Input»
4. Selezionare il file dal quale prelevare la navigazione. NOTA: va bene qualsiasi file di quelli presenti nell’elenco, 

perché tutti contengono la navigazione nelle header.

3. Doppio click
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5. Doppio click sul modulo «Edit Header». Si aprirà la finestra «Edit/Define Header Mapping». Nell’elenco delle 
header su cui si andrà operare dovrebbero comparire le voci VWUSER_1 e VWUSER_2 (il flow è preimpostato 
perciò non sono necessarie modifiche. Nella nota sottostante, viene illustrata la procedura da seguire per 
aggiungere ulteriori voci.

5. Doppio click

AZIONI

NOTA Per aggiungere altre voci all’elenco, cliccare sul pulsante Attr, tenendo premuto il pulsante del mouse spostarsi 
sul simbolo «User» (1); scegliere quindi dal menu a tendina il valore desiderato (2) e cliccare sul «+» verde (3)

1

2

3
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6. Doppio click sul quadratino a fianco dell’articolo in lista. Si aprirà la finestra «Dictionary Item: VWUSER». In 
questo ambiente è possibile definire l’operazione da eseguire sulla header selezionata. Il flow fornito è già 
stato compilato con due operazioni preimpostate (*), non è perciò necessario apporre alcun cambiamento.

7. Confermare premendo il pulsante «-».

AZIONI

* Le operazioni preimpostate sono:
- Assegnazione alle header VWUSER_1 e 

VWUSER_2 del valore XSHOT e YSHOT 
rispettivamente.

- Divisione per 3600 per ottenere il valore in gradi

6

7

8

8. Cliccare il pulsante «SAVE» nella finestra «Low
Command Edit/Define Header Mapping»
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9. Doppio click sul comando «TextWrite», che definisce le voci di header da esportare in formato testo. Si aprirà 
la finestra «Write ASCII Attribute Values».

10. Fare click sul pulsante grigio per attribuire il nome al file che si andrà a salvare.

9. Doppio click

AZIONI

11

11. Selezionare la cartella Navigazione/FROM 
VISTA e attrbiuire il nome



2.13 Esportare i dati di navigazione                                    8/11

Nel nostro caso andremo ad esportare i seguenti elementi:

L’elenco degli elementi da esportare è ispezionabile attraverso il menu a 
tendina della maschera «Write ASCII Attribute Output File». La loro posizione 
(colonne da-a) e il numero di decimali che seguono l’intero sono riportati nelle 
soprastanti caselle di testo (e sono modificabili a piacimento). 

1. SHOT_POINT_NO, colonne 1-9, nessun decimale;
2. VWUSER_1, colonne 11-19, 8 decimali;
3. VWUSER_2, colonne 21-29, 8 decimali.

Il separatore scelto è la virgola

AZIONI

12. Confermare con OK

12



2.13 Esportare i dati di navigazione                                    9/11

AZIONI

13. Selezionare i tre moduli
14. Far partire il flow cliccando il pulsante «GO»

Il file generato (in questo caso aperto in wordpad) dovrebbe 
apparire come illustrato di fianco. Nelle prime tre righe 
sono riportati gli estremi degli elementi esportati. Seguono 
le colonne con in singoli valori

13

14



2.13
Qualora si desiderasse aggiungere ulteriori elementi da esportare, ad esempio la profondità dell’acqua (Topas riceve 
l’informazione dal multibeam e la immagazzina nella header «WATER_DEPTH_SHOT»), procedere come segue: 

1. Fare click sul pulsante «NEW»;
2. Fare click sul tast «Attr» e, tenendo premuto il 

pulsante del mouse, selezionare «GEO»
3. Nella lista che comparirà, selezionare la voce 

«WATER_DEPTH_SHOT»

1

AZIONI

2

3
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La voce «WATER_DEPTH_SHOT» sarà aggiunta in quarta posizione tra gli elementi da esportare.
Il software provvederà a collocare automaticamente l’elemento alla prima colonna utile (in questo caso dalla 31 alla 39).
Il numero di decimali di default è 2, ma è possibile aumentarlo o diminuirlo agendo sui pulsanti freccia immediatamente a 
destra.
Il file che verrà generato conterrà una quarta riga descrittiva dell’elemento aggiunto, e una quarta colonna con i singoli 
valori.
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Questa slide e quella successiva contengono una breve digressione sulle operazioni che possono essere effettuate sulle 
header attraverso il modulo «Edit Header».
Quando si accede alla finestra «Dictionary Item: NomeItem» non compilata, la «Dictionary Scaling List» è vuota. Per 
popolarla di «operazioni», seguire la seguente procedura.

1. Per assegnare (come nel nostro caso) alla header selezionata (VWUSER_1) il valore di un’altra header, fare 
click sul pulsante «ITEM». Si aprirà la finestra «Item Function»

2. Spuntare il radio button «Assign Item»
3. Cliccare sull’icona Attr e, tenendo premuto, selezionare la voce «GEO».
4. Selezionare la voce XSHOT dal menu a tendina e confermare.

AZIONI

1

2

3

4

Facendo girare il flow contente questo comando, la 
voce di header XSHOT sarà replicata nella voce di 
header VWUSER_1



2.14

Se, oltre ad assegnare a una header il contenuto di un’altra header, si volesse compiere un’operazione aritmetica sulla 
header, seguire la seguente procedura: 

5. Fare click sul pulsante «CONSTANT». Si aprirà la finestra «Constant Defn.»
6. Spuntare il radio button «Divide Constant»
7. Scrivere il valore del divisore nella casella di testo
8. Confermare con OK. L’operazione sarà aggiunta alla «Dictionary Scaling List»

AZIONI

5

6

7

8

RIEPILOGO L’applicazione del flow avrà avuto come risultato quello di popolare la header VWUSER_1 con i valori della 
header XSHOT divisi per 3600. 
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